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Instruccions per a l’usuari del Saver EVO
El programari Saver EVO permet recuperar les dades dels esdeveniments de desfibril·lació d’un HeartSine samaritan 
PAD i de la targeta de memòria d’un PDU. El Saver EVO també permet gestionar les dades d’esdeveniments que s’hagin 
desat en un ordinador per a imprimir-les i per a importar-les i exportar-les a altres usuaris dels programaris Saver i 
Saver EVO.

El Saver EVO se subministra amb una llicència de programari que permet instal·lar-lo i utilitzar-lo en un sol ordinador 
que disposi del Microsoft Windows (preferiblement, el Windows 10).

Descàrrega des del lloc web
És possible que la instal·lació del Saver EVO necessiti permisos d’administrador. En aquest cas, poseu-vos en contacte 
amb l’administrador del sistema o amb el vostre proveïdor de serveis informàtics.

1.	 Aneu a heartsine.com i descarregueu el programari Saver EVO corresponent al vostre país.

2.	 Un cop descarregat, executeu el fitxer «SaverEVO_setup.exe» per a instal·lar el Saver EVO. (Seguiu les instruccions 
que veureu a la pantalla.)

3.	 Llegiu el contracte de llicència d’usuari. Per a poder instal·lar aquest programari, heu d’acceptar els termes i 
condicions del contracte. Per a acceptar-los, feu clic al botó «Next» (Següent).

4.	 El Saver EVO s’instal·larà a la ubicació predeterminada amb la configuració estàndard. Feu clic al botó «I agree» 
(Acceptar) per a continuar la instal·lació. No modifiqueu la configuració estàndard si no sou un usuari expert.

5.	 Si l’instal·lador us demana un certificat per al controlador del dispositiu, feu clic al botó «Continue anyway» 
(Continuar de tota manera).

Instruccions ràpides
Per a recuperar dades d’esdeveniments de desfibril·lació enregistrades en un HeartSine samaritan PAD o a la targeta de 
memòria d’un PDU:

1.	 Connecteu el dispositiu rellevant a l’ordinador.

2.	 Obriu el programari EVO Saver.

3.	 Feu clic al botó  o al botó .

4.	 Feu clic al botó  per a veure la llista d’esdeveniments desats.

5.	 Marqueu a la llista l’esdeveniment enregistrat que necessiteu.

6.	 Feu clic al botó  per a veure l’esdeveniment.

7.	 Feu clic al botó  i introduïu la informació de pacient que calgui per a desar l’esdeveniment a l’ordinador. 

8.	 Si voleu imprimir el registre de l’esdeveniment, feu clic a .
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Com utilitzar el Saver EVO 
La imatge següent mostra la pantalla d’inici del Saver EVO.

Pantalla d’inici del Saver EVO

samaritan PAD
Obre el menú de funcions específiques per al HeartSine samaritan PAD. 
Per a més informació, vegeu la pàgina 4

samaritan PDU
Obre el menú de funcions específiques per al PDU. Per a més 
informació, vegeu la pàgina 9

Manage Saved Events (Gestionar 
esdeveniments desats)

Obre el menú de funcions específiques per als esdeveniments desats a 
l’ordinador. Per a més informació, vegeu la pàgina 12

Exit Saver EVO (Sortir del Saver EVO) Tanca el programari Saver EVO

Canviar la contrasenya del Saver EVO
Permet canviar la contrasenya i seleccionar l’idioma del Saver EVO. 
També permet veure la informació de revisió del Saver EVO

L’ús d’aquests menús s’explica detalladament als apartats corresponent

Com utilitzar el Saver EVO amb el HeartSine samaritan PAD
Per a utilitzar el Saver EVO amb el HeartSine samaritan PAD, necessiteu el cable de dades USB, que és possible 
que s’hagi subministrat amb el HeartSine samaritan PAD. Si no teniu el cable, poseu-vos en contacte amb el vostre 
representant comercial o distribuïdor autoritzat de Stryker. Si el DEA té connectat un mòdul de comunicació HeartSine 
Gateway, podeu utilitzar un cable micro-USB.

1.	 Connecteu el cable de dades USB al HeartSine samaritan PAD i a un port USB de l’ordinador. Obriu el programari 

Saver EVO.
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2.	 Feu clic al botó «samaritan PAD» i s’obrirà la finestra següent.

Pantalla d’accés al PAD del Saver EVO

PAD Data (Dades del PAD)
Feu clic en aquest botó per a recuperar les dades d’esdeveniments del  
HeartSine samaritan PAD. Per a més informació, vegeu la pàgina 5

Change PAD Settings (Canviar la 
configuració del PAD)

Feu clic en aquest botó per a fer les proves de diagnòstic o modificar la 
configuració (el volum i l’hora) del HeartSine samaritan PAD. Per a més 
informació, vegeu la pàgina 7

Back (Enrere) Feu clic en aquest botó per a tornar a la pantalla d’inici del Saver EVO

Recuperació de dades d’esdeveniments del HeartSine samaritan 
PAD
Per a recuperar les dades dels esdeveniments de desfibril·lació del HeartSine samaritan PAD, assegureu-vos que aquest 
estigui connectat a l’ordinador i, aleshores, feu clic al botó «PAD Data» (Dades del PAD). El programari farà una cerca 
a la memòria del HeartSine samaritan PAD i apareixerà una llista amb tots els esdeveniments enregistrats (vegeu la 
imatge següent).

Pantalla del Saver EVO amb la llista del registre d’esdeveniments del PAD
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Els esdeveniments amb el text de color verd i el símbol  són esdeveniments que ja s’han desat a l’ordinador.

Save All (Desar-ho tot)

Si feu clic al botó «Save All» (Desar-ho tot), tots els esdeveniments del registre 
d’esdeveniments del PAD es desaran a l’ordinador en un sol fitxer

Nota: Els esdeveniments que s’hagin desat amb aquest botó no es poden recuperar 
ni visualitzar en aquesta versió del programari Saver EVO. Si voleu recuperar els 
esdeveniments d’aquest fitxer, poseu-vos en contacte amb el servei d’atenció al client 
de HeartSine Technologies. Per a desar els esdeveniments individualment i poder-los 
recuperar més endavant, utilitzeu la funció «Save» (Desar), que es descriu a l’apartat 
Visualització dels esdeveniments d’un HeartSine samaritan PAD, a la pàgina 6

View (Veure) Si feu clic en aquest botó, es visualitzarà l’esdeveniment selecciona 

Erase (Esborrar)
Erase (Esborrar): Si feu clic en aquest botó, s’esborraran tots els esdeveniments del 
registre d’esdeveniments del HeartSine samaritan PAD. Per a més informació i consells 
sobre com esborrar dades vegeu la pàgina 7

Back (Enrere) Feu clic en aquest botó per a tornar a la pantalla d’accés al PAD del Saver EVO

Visualització dels esdeveniments d’un HeartSine samaritan PAD
1.	 Per a visualitzar un esdeveniment, marqueu-lo a la llista i feu clic al botó «View» (Veure). Es mostrarà 

l’esdeveniment de desfibril·lació, amb el traçat de l’ECG i el registre d’esdeveniments en una sola finestra.

Finestra del Saver EVO amb informació dels pacients 
del PAD

Finestra de visualització d’esdeveniments del PAD del 
Saver EVO

2.	 Ara podeu desar a l’ordinador l’esdeveniment visualitzat fent clic al botó «Save» (Desar). Els esdeveniments desats 
d’aquesta manera es poden recuperar i visualitzar amb el Saver EVO. Això permet introduir informació per a poder 
identificar el pacient a la llista d’esdeveniments desats de l’ordinador. La informació sobre el pacient ha de contenir 
caràcters alfanumèrics i podeu emplenar tots els camps o deixar-ne alguns en blanc, si voleu.

Nota: Les dades dels esdeveniments de desfibril·lació, un cop desades a l’ordinador, no es poden modificar
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La finestra de visualització d’esdeveniments del Saver EVO també conté els botons següents: 

Print (Imprimir)
Feu clic en aquest botó per a imprimir l’esdeveniment que mostra la finestra de 
visualització

Print Preview (Vista 
prèvia d’impressió)

Feu clic en aquest botó per a previsualitzar a la pantalla les dades que s’imprimiran

Back (Enrere)
Feu clic en aquest botó per a tornar a la pantalla del Saver EVO que mostra la llista del 
registre d’esdeveniments del PAD

Com esborrar la memòria d’un HeartSine samaritan PAD
1.	 Per a esborrar la memòria d’un HeartSine samaritan PAD, feu clic al botó «Erase» (Esborrar). 

2.	 Com a precaució, abans d’esborrar la memòria, el Saver EVO us demanarà que introduïu la contrasenya. Després 
d’introduir la contrasenya adequada, s’esborrarà la memòria del HeartSine samaritan PAD. Per a més informació 
sobre com canviar la contrasenya predeterminada, consulteu l’apartat Com canviar la contrasenya del Saver EVO, 
a la pàgina 14. 

Quan recupereu les dades d’esdeveniments del HeartSine samaritan PAD i les deseu l’ordinador, és recomanable 
que esborreu els esdeveniments de la memòria del HeartSine samaritan PAD. D’aquesta manera, es garanteix que 
disposeu de tota la memòria per a enregistrar dades d’un altre esdeveniment de desfibril·lació.

 Atenció: HeartSine recomana que descarregueu tota la memòria del HeartSine samaritan PAD abans d’esborrar-la 
i que deseu aquesta informació d’una manera segura per a futures consultes 

Com canviar la configuració del HeartSine samaritan PAD
El botó «Change PAD Settings» (Canviar la configuració del PAD) permet configurar les funcions següents del HeartSine 
samaritan PAD:

•	Comprovar/Ajustar l’hora

•	Efectuar les proves de diagnòstic

A més, els usuaris que tinguin permisos d’administrador poden canviar els paràmetres següents:

•	Volum

•	Activació i desactivació del so del metrònom

1.	 Feu clic al botó «Change PAD Settings» (Canviar la configuració del PAD) per a accedir a la pròxima pantalla:

Finestra de modificació de la configuració del PAD del Saver EVO
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Check/Set PAD Time (Comprovar/Ajustar l’hora del PAD)
Aquest botó permet sincronitzar l’hora del HeartSine samaritan PAD amb la de l’ordinador.

Finestra del Saver EVO per a comprovar/ajustar l’hora del PAD

1.	 Feu clic al botó «Synchronize» (Sincronitzar) per a ajustar l’hora del HeartSine samaritan PAD a la mateixa que 
l’ordinador al qual està connectat.

2.	 Feu clic al botó «Close» (Tancar) per a tornar a la finestra  Change PAD Settings (Canviar la configuració del PAD) del 
Saver EVO.

Run Diagnostic Tests (Efectuar les proves de diagnòstic)
Aquest botó permet efectuar diverses proves bàsiques que verifiquen que el HeartSine samaritan PAD funcioni 
correctament. Podeu accedir a la llista de proves de diagnòstic disponibles des del menú desplegable que es mostra a la 
imatge següent.

Finestra de les proves de diagnòstic del PAD del Saver EVO

El Saver EVO identificarà el tipus de dispositiu PAD que està connectat i mostrarà les etiquetes informatives adequades 
per a guiar l’usuari durant les proves. 
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Edit PAD Configuration (Editar la configuració del PAD)
Feu clic en aquest botó per a obrir la finestra d’edició de la configuració del PAD (vegeu la imatge següent), on podeu 
veure i canviar la configuració del volum i del metrònom i consultar la versió del programari del dispositiu HeartSine 
samaritan PAD connectat. Per a confirmar els canvis, el Saver EVO us demanarà que introduïu la contrasenya. Per a 
més informació sobre com canviar la contrasenya predeterminada, consulteu l’apartat Com canviar la contrasenya del 
Saver EVO, a la pàgina 14.

Finestra d’edició de la configuració del PAD del Saver EVO

Com utilitzar el Saver EVO amb un PDU*
1.	 Per a utilitzar el Saver EVO amb la targeta de memòria d’un samaritan PDU, heu d’introduir la targeta en un 

lector de targetes MMC/SD compatible que estigui connectat o integrat a l’ordinador en què feu servir el Saver 
EVO. Tingueu en compte que el sistema operatiu de l’ordinador pot tardar uns segons, fins i tot més d’un minut, a 
detectar que hi ha una targeta al lector de targetes. 

2.	 Des de la pantalla d’inici, feu clic al botó «samaritan PDU». S’obrirà la finestra següent.

Pantalla d’accés al PDU del Saver EVO

* El samaritan PDU no estava disponible als Estats Units i HeartSine ja no comercialitza aquest producte.
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PDU Data (Dades del PDU)
Feu clic en aquest botó per a recuperar les dades d’esdeveniments de la targeta 
de memòria d’un PDU. Per a més informació, vegeu la pàgina 10

PDU Settings (Configuració 
del PDU)

Feu clic en aquest botó per a veure els paràmetres de configuració. Per a més 
informació, vegeu la pàgina 12

Back (Enrere) Feu clic en aquest botó per a tornar a la pantalla d’inici del Saver EVO

Recuperació de dades d’esdeveniments de la targeta de memòria 
d’un PDU
Comproveu que la targeta de memòria del samaritan PDU estigui ben col·locada al lector de targetes SD/MMC i, 
aleshores, feu clic al botó «PDU Data» (Dades del PDU). Apareixerà una llista amb els esdeveniments que estan 
enregistrats a la targeta de memòria.

Pantalla del Saver EVO amb la llista del registre d’esdeveniments del PDU

 

Els esdeveniments assenyalats amb el símbol d’un rellotge  són proves automàtiques del PDU que s’han dut a terme 
correctament.

Els esdeveniments amb el text de color verd i el símbol  són esdeveniments que ja s’han desat a l’ordinador.

Save All (Desar-ho tot) Aquest botó no està disponible en el mode PDU 

View (Veure)
Si feu clic en aquest botó, es visualitzarà l’esdeveniment seleccionat. Per a més 
informació, vegeu la pàgina 11

Erase (Esborrar) Aquest botó no està disponible en el mode PDU

Back (Enrere) Feu clic en aquest botó per a tornar a la pantalla d’accés al PDU del Saver EVO
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Visualització d’esdeveniments desats en un PDU 
1.	 Per a visualitzar un esdeveniment, marqueu-lo a la llista i feu clic al botó «View» (Veure). Es mostrarà 

l’esdeveniment de desfibril·lació, amb el traçat de l’ECG i el registre d’esdeveniments en una sola finestra:

 
Finestra de visualització d’esdeveniments del PDU del Saver EVO

2.	 	Ara podeu desar a l’ordinador l’esdeveniment visualitzat fent clic al botó «Save» (Desar). Aquesta acció us dona la 
possibilitat d’introduir informació per a poder identificar el pacient. La informació sobre el pacient ha de contenir 
caràcters alfanumèrics i podeu emplenar tots els camps o deixar-ne alguns en blanc, si voleu.

 
Finestra del Saver EVO amb informació dels pacients del PDU

Nota: Les dades dels esdeveniments de desfibril·lació, un cop desades a l’ordinador, no es poden modifica

La finestra de visualització d’esdeveniments del Saver EVO també conté els botons següents: 

Print (Imprimir)
Feu clic en aquest botó per a imprimir l’esdeveniment que mostra la finestra de 
visualització

Print Preview (Vista 
prèvia d’impressió)

Feu clic en aquest botó per a previsualitzar a la pantalla les dades que s’imprimiran

Back (Enrere)
Feu clic en aquest botó per a tornar a la pantalla del Saver EVO que mostra la llista del 
registre d’esdeveniments del PDU
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Visualització de la configuració d’un PDU
Feu clic al botó «PDU Settings» (Configuració del PDU) per a accedir a la pantalla de configuració del PDU (vegeu la 
imatge següent). En aquesta pantalla podeu veure l’estat de la bateria, el volum dels altaveus, l’idioma, la configuració 
del metrònom, la velocitat i la durada de l’RCP, la data de caducitat, la versió del programari i el número de sèrie del 
dispositiu PDU. La configuració només es pot visualitzar. No podeu modificar-la.

Finestra de configuració del PDU del Saver EVO

Com utilitzar el Saver EVO amb esdeveniments desats
El botó «Manage Saved Events» (Gestionar esdeveniments desats), situat a la pantalla principal del Saver EVO, permet 
revisar les dades d’esdeveniments que s’han descarregat des del HeartSine samaritan PAD, la bateria samaritan Data-
Pak o la targeta de memòria del PDU i desar-les a l’ordinador. 

1.	 	Si feu clic en aquest botó, s’obrirà la finestra següent:

2.	 	Si marqueu un esdeveniment a la llista i feu clic a «View» (Veure), s’obrirà l’esdeveniment desat, amb el traçat de 
l’ECG i el registre d’esdeveniments.
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Exportació i importació
El Saver EVO disposa de funcions que permeten rebre o enviar dades d’esdeveniments de desfibril·lació a altres usuaris 
que facin servir el programari Saver EVO. Per a rebre o enviar còpies d’esdeveniments desats, utilitzeu les funcions 
Import (Importar) i Export (Exportar) del Saver EVO.

Per a exportar esdeveniments:
1.	 	A la pantalla Manage Saved Events (Gestionar esdeveniments desats), marqueu l’esdeveniment o els esdeveniments 

que voleu exportar i, aleshores, feu clic al botó «Export» (Exportar).

2.	 	L’ordinador us demanarà que indiqueu la ubicació on voleu desar el fitxer exportat i mostrarà un camp de text on 
podeu escriure un nom per al fitxer.

3.	 	Feu clic al botó «Save» (Desar) per a desar el fitxer a la ubicació que heu seleccionat.

Ara, si voleu, podeu adjuntar aquest fitxer a un missatge de correu electrònic del vostre programari de correu electrònic 
habitual i enviar el fitxer exportat a un altre usuari que faci servir el programari Saver EVO.

Les dades d’esdeveniments del Saver EVO només poden visualitzar-les els usuaris que també disposin del Saver EVO. 
L’anterior programari Saver no pot importar ni visualitzar correctament dades del Saver EVO.

Per a importar esdeveniments:

Per a importar esdeveniments i visualitzar-los a l’ordinador, primer heu de desar en una ubicació de l’ordinador el fitxer 
que us hagi enviat un altre usuari dels programaris Saver o Saver EVO.

1.	 	Des de la pantalla Manage Saved Events (Gestionar esdeveniments desats) del Saver EVO, feu clic al botó «Import» 
(Importar).

2.	 	Aneu fins a la ubicació on heu desat el fitxer i feu clic a «Open» (Obrir).

3.	 	Els registres s’afegiran a la llista de fitxers del Saver EVO de l’ordinador.

Per a visualitzar aquests registres, marqueu un esdeveniment a la llista i feu clic al botó «View» (Veure).

El Saver EVO pot importar i mostrar correctament les dades d’esdeveniments que s’hagin exportat amb la 
versió anterior del programari, anomenada Saver.

Per a esborrar esdeveniments desats:
Des del Saver EVO podeu esborrar els esdeveniments desats a la memòria de l’ordinador. Podeu eliminar un sol 
esdeveniment o diversos alhora, marcant a la llista els que vulgueu esborrar. 

Després de confirmar que voleu eliminar els esdeveniments seleccionats, feu clic al botó «Erase» (Esborrar).  
Com a precaució, abans d’esborrar la memòria, el Saver EVO us demanarà que introduïu la contrasenya. Després 
d’introduir la contrasenya adequada, la memòria que conté els esdeveniments seleccionats s’esborrarà de l’ordinador.

 Atenció: Abans d’esborrar la memòria, comproveu que hàgiu seleccionat només els esdeveniments que voleu 
eliminar realment. Un cop esborrats de l’ordinador, els esdeveniments de la memòria no es poden recuperar i es perdrà 
tota la informació que contenen  
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Com canviar la configuració del Saver EVO
El Saver EVO disposa d’algunes funcions que només es poden utilitzar o modificar introduint una contrasenya. 
D’aquesta manera, els administradors del programari poden restringir l’accés a determinades funcions només als 
usuaris autoritzats. Després d’instal·lar el Saver EVO, la contrasenya predeterminada és «password».

Per a canviar la contrasenya:

1.	 	Des de la pantalla principal del Saver EVO, feu clic al petit botó «Configuració». S’obrirà la finestra següent:

Pantalla de modificació de la configuració

2.	 	Introduïu la contrasenya actual i feu clic a «Confirm» (Confirmar).

3.	 	Introduïu la nova contrasenya dues vegades i feu clic a «Apply» (Aplicar) perquè es dugui a terme el canvi. 

4.	 Feu clic a «OK» per a tancar la finestra de modifcació de la contrasenya.

Nota: Si torneu a instal·lar el Saver EVO, la contrasenya tornarà a ser la predeterminada. Aquesta acció, tanmateix, 
no esborra les dades d’esdeveniments que hàgiu desat prèviament
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Per a canviar l’idioma del Saver EVO: 
1.	 	Per a seleccionar l’idioma del Saver EVO, escolliu-ne un a la llista desplegable i feu clic a «Apply» (Aplicar).

2.	 	Després de fer clic a «Apply» (Aplicar), s’obrirà la pantalla següent i haureu de reiniciar el Saver EVO perquè 
s’apliqui el canvi d’idioma.

3.	 	Feu clic a «Yes» (Sí) per a tancar el Saver EVO o feu clic a «No» si no voleu reiniciar el programari.

Per a comprovar si hi ha actualitzacions automàtiques:
1.	 	Si la casella «Enable» (Activar) està marcada, el Saver EVO intentarà connectar-se al lloc web de HeartSine cada 

vegada que obriu el programari per a comprovar si hi ha versions més recents del Saver EVO. Si hi ha alguna 
actualització disponible, apareixerà la finestra següent quan obriu el Saver EVO.

2.	 	Seleccioneu «Yes» (Sí) o «No» per a indicar si voleu o no voleu descarregar la versió actualitzada del Saver EVO.



Ciberseguretat
•	Comproveu que l’ordinador tingui instal·lades totes les actualitzacions de seguretat de Microsoft 

•	De tant en tant, feu una còpia de seguretat de l’ordinador (inclosos els fitxers del Saver EVO)

•	És recomanable instal·lar a l’ordinador un programari antivirus i un programari que protegeixi contra codi maliciós. 
Comproveu que estiguin activats i manteniu-los actualitzats

•	Feu servir una contrasenya sòlida per a l’inici de sessió a l’ordinador. La contrasenya hauria de contenir lletres 
minúscules i majúscules, números i símbols

Per obtenir més informació, poseu-vos en contacte amb nosaltres escrivint a  
heartsinesupport@stryker.com o visiteu el nostre lloc web: heartsine.com

Stryker i les seves filials són propietàries, fan servir o han sol·licitat les següents marques comercials o marques de servei: 
HeartSine, HeartSine Gateway, samaritan, Saver EVO, Stryker. La resta de marques comercials són marques comercials dels seus 
respectius propietaris o titulars.
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